The REAPER User Guide is in the process of being updated for REAPER 6.0. It will be some time before this is completed. Meanwhile, this document is intended to serve as an interim introduction to the main changes introduced in REAPER 6.

This short guide does not document the many performance improvements and bug fixes that require no action on the part of the user. Moreover, it does not aim to list every single feature change, but it does cover those which are likely to be of most interest to most users and/or might be the least easy to find or follow.

The entire 6.0 changelog is included as an appendix to this document.

Please also note that this upgrade guide provides only an overview, and assumes that you already have an existing basic working knowledge of REAPER 4 or REAPER 5. It is not intended to meet the needs of the entirely new user.

Geoffrey Francis
# Table of Contents

1 Major Theme (and Theme Related) Changes ................................................................. 5  
   Theme Adjuster (Overview) ......................................................................................... 5  
   Other TCP Changes ................................................................................................. 7  

2 FX Changes and New Options ..................................................................................... 7  
   Embedded FX ........................................................................................................... 7  
   VST3 Changes ......................................................................................................... 7  
   FX Window Layout ................................................................................................. 7  
   ReaFir ...................................................................................................................... 8  

3 Track Wiring View ...................................................................................................... 8  

4 Menu Changes .......................................................................................................... 10  
   Edit and View Menus .............................................................................................. 10  

5 MIDI Editor Changes ................................................................................................. 11  
   The MIDI Toolbar .................................................................................................. 11  
   Note/Event Properties ............................................................................................ 11  
   Display Note Length in Velocity Lane ...................................................................... 11  
   Other CC Lane Enhancements .............................................................................. 12  
   MIDI Editor Preferences ....................................................................................... 12  
   Move Bank/Program changes with Notes ............................................................ 13  
   MIDI Editor Mouse Modifiers ............................................................................... 13  
   Notation Editor Menus .......................................................................................... 13  

6 Other Performance Preferences .................................................................................. 13  

7 Media Item Enhancements .......................................................................................... 13  
   Dynamic Split ......................................................................................................... 13  
   Stretch Markers ...................................................................................................... 14  
   Auto-Stretch at Tempo Changes ............................................................................. 14  

8 Playback Offset Enhancements ................................................................................... 14  
   Playback Time Offset ............................................................................................. 14  

9 File Rendering Enhancements ..................................................................................... 14  
   Changes to Presets .................................................................................................. 14  

10 File Rendering Enhancements .................................................................................... 15  
   Rendering with Tempo Embedded ......................................................................... 15  

11 Embed Transient Information in WAV and AIFF Files ............................................... 15  

Appendix: Complete REAPER 6.00 Changelog .............................................................. 17
1 Major Theme (and Theme Related) Changes

The new default TCP layout is shown here (left).

In particular, note:

- By default, **input monitoring** is now enabled for new tracks. This can be disabled from the record arm button right-click menu.

- For existing users, the purpose of the various track controls should be self apparent. As you might expect, these controls will automatically wrap according to any changes you make to track height and/or width (see example, above right).

- The default MCP layout has also changed (see right). Again, the existing users should have no difficulty in recognising the various controls and their purpose.

- The Master track layout (TCP and MCP) has also changed. Again, you should have no problem in identifying the different controls and functions.

So what’s the big deal then?
The new REAPER theme allows you a great deal of customization of your TCP, MCP and more. It does this using a script. To run this script:

- Choose **Options, Theme** from REAPER’s Actions menu.
- Select **Theme Adjuster**.

You can customize the Actions menu so that it always includes this script as an option. To do this, use the **Options, Customize menus/toolbars** command.

Theme Adjuster (Overview)
The theme adjuster lets you customize any of the following:

- The Track Control Panel
- The Mixer Control Panel
- Your Custom Color Schemes
- Your Envelopes
- Your Transport Bar

Make your selection using the left and right arrows displayed near the top of the Theme Adjuster window.

The icon shown on the left (above) can be used to obtain Help. The icon on the right can be used to dock the Theme Adjuster window.
The Track Control Panel

There's a lot of goodies here. Let's take a look at some of them – then you can explore for yourself!

- The folder controls will apply to all folders in your project. They determine the extent to which your folders will be indented, and whether or not controls are aligned within folders.
- You can zoom to any selected track or selection of tracks by clicking on one of the three options of 100%, 150% or 200%.
- You can use the appropriate left/right arrows to determine the amount of track panel space allocated to the track name, the volume control, the input and the meter. Note that increasing volume size will change its appearance from a knob to a fader.
- You can also set the meter location to left or right.
- You are presented with three possible layouts (A, B and C), each with a list of options. For example, for each layout you can choose not to display any specified controls in the TCP if the mixer is available, or if the track is not selected, or if the track is not armed. There is also an option to always hide any
unwanted controls. For example, if you don’t want to see the volume controls in the TCP when the mixer is displayed, clicking on that item would set its status to HIDE (see below right).

- To change from one layout to another (e.g., A to C), first make your track selection, click on the required layout header (A, B or C), then on 100%, 150% or 200%.

Notice also the tooltips and context help messages that pop up from time to time. They will help you to get the most out of the Theme Adjuster.

**The Mixer Control Panel**

The method of working here is similar to that used in the Track Control Panel. By and large, these options should be mostly self-explanatory.

**The Custom Colors**

You are offered six color palettes from which to choose. After selecting a palette, you can make any selection of tracks then click on any color in that palette to color the TCP/MCP for those tracks.

Note that currently changes made in this manner are not undoable from within the Theme Adjuster. You will need to return focus to REAPER’s main window to be able to undo changes.

**The Envelopes/Transport Panel**

Again, the method of using these controls should by now be fairly self-evident.

**Other TCP Changes**

You now have the option of moving the Track Control Panel to the right hand side of the screen. The toggle command **Show TCP on right side of Arrange** is available on the empty TCP area right-click context menu.

### 2 FX Changes and New Options

**Embedded FX**

It is now possible to embed the GUI in the TCP/MCP for a limited number of FX, notably ReaEQ, ReaComp, ReaXComp, ReaSurround and some graphical JS plugins.

Right-click over the FX in the track’s FX chain and choose **Show embedded UI in TCP** or **MCP**. Two examples are shown left and below.

In the example below, (ReaEQ), you could adjust the visible parameters within the TCP.

**VST3 Changes**

REAPER now supports VST3 plugins that export MIDI note names.

**FX Window Layout**

Preferences have been added (Options, Preferences, Plug-ins) to allow the display of the **FX list on right side of FX chain window** and/or **FX buttons above FX list** if you prefer.
ReaFir
Right-click over graph area for a menu that includes configuration options.
These include processing mode (see right), FFT size, Quality settings and Edit mode.

3 Track Wiring View
Until now, there have been three main ways of managing track routing within REAPER.
- Drag and drop in TCP or MCP view.
- Using a track's routing window.
- Using the Routing Matrix.

Now you have a fourth option – using Track Wiring. You might be wondering what is the point of providing a fourth option. The answer is that the main strength of Track Wiring view is less in its suitability for creating routing and more in its ability to provide you with an overview of your project’s routing, and to manage it. For example, it can help you to identify any routing you may have created and forgotten about, but which needs to be deleted.

This section introduces you to Track Wiring and explores its environment. Track Wiring is accessed directly from the View menu. Let’s start with a simple example.
Above you see (above) the track wiring view for a project with three tracks – two guitar tracks and one reverb track.

- The solid straight white lines depict sends to the master.
- Click and hold on any track name to drag and drop it around at will.
- The curved lines represent sends from one track to another (from each guitar track to the reverb track).
- The little arrow next to the track number can be used to collapse/expand the display of detailed track information for individual tracks. This can be especially useful if your file has a large number of tracks and/or more complex routing (as shown, for example, below). Notice also how the two folders (Vocals and Music) and their child tracks are depicted.

- In "normal" mode for each track the following overview information is displayed: track number and name, media, fx, fader information, channels and any sends. Let's look at an example.
The Gtr Neck track shown here (above) contains media, one FX (ReaComp) one send (to the Reverb track) and a send to the master. It consists of two channels (indicated by the two vertical lines on the right.

The Reverb track contains no media, has receives from tracks 1 and 2, contains ReaVerbate and also directs its two channel output to the master.

Click on any FX name to open its UI – here you can adjust any of its parameters. Click where shown here (right) to display full routing information for that FX.

Click on the text “Fader” to open the routing window for that track: this has the same effect as clicking on the Route button in the TCP or MCP. Here you can modify, add or delete sends and/or receives for this track.

Click on the text “Send” to open the routing window for that send. You can modify or delete this send.

The more complex the project, the more bewildering the track wiring diagram can be. This is where the context menu can be helpful. Right click anywhere in the Track Wiring window to display the menu shown below.

You can switch between any of the four modes shown: this can be especially useful for switching between the track wiring diagram and the routing matrix.

You can “unclutter” the diagram using any or all of the three toggle options shown – Only show wires on track on mouseover, Only show hardware output/input wires on track mouseover, and Show routing controls when creating send/hardware output.

4 Menu Changes

Edit and View Menus
Some of REAPER’s main menus have been given a face lift, in particular the Edit and View menus.

- Dynamic Split, Transient Detection Settings, Crossfade Editor and Nudge/Set Items now appear on the Edit menu.
- Items on the View menu are now grouped by concept rather than listed alphabetically.
5 MIDI Editor Changes

You'll notice quite a few changes in REAPER's MIDI Editor, starting with a new color scheme. However, the changes go well beyond that.

The MIDI Toolbar

Buttons are now available not only for the four views – Piano Roll, Named Note, Event List and Notation Editor, but also for the three note shapes Rectangle, Triangle and Diamond. These latter three are not available in Event List view.

Note/Event Properties

These are now both accessed via a common dialog box (see below). The type of event to be displayed can be selected from the drop down list (below right).

Display Note Length in Velocity Lane

You now have an option to display note length in the velocity lane. From the Options menu choose CC/velocity lane then Show note length in velocity lane. The information is presented as shown below:
Other CC Lane Enhancements

REAPER 6 introduces other improvements in the way data is displayed in CC lanes. A combination of lines and curves (very similar to REAPER’s Arrange View envelopes) can be used, in conjunction with freehand drawing in pencil mode.

Curve shape can be selected from the CC lane context menu (left).

These are Linear, Square, Slow start/end, Fast start, Fast end and Bezier.

Points are added by double clicking, or shift double clicking to also open the properties dialog, e.g. to change the point shape.

Alternatively, to use the pencil tool, click and drag.

Below are shown some examples

Here (above left) we have created a pan envelope by double clicking where required, adding linear points. Later (above right) we change our mind, so after marqueeing the points to select them (right click hold drag) we have used the context menu to change their shape to square.

Here (left) we have used the pencil tools to create a freehand curve.

MIDI Editor Preferences

New options have been added to your Preferences, Editing Behavior, MIDI Editor section, principally to assist with the tasks described above.

These enable you to select a default shape for CC lane segments, and to reduce the number of CC events when drawing.
Move Bank/Program changes with Notes
The same Options, CC/velocity lane menu as we encountered earlier also offers you the option for Bank/program selection to follow note selection.

MIDI Editor Mouse Modifiers

![MIDI CC Event double-click mouse modifiers now include an option to Reset event to default value.](image)

MIDI CC lane left click/drag page now includes an option (just above the OK button) to Draw /edit events immediately on mouse click.

Notation Editor Menus
More MIDI Editor toolbars and menus can now be customised, in particular the Notation Editor Staff and Note context menus. This can be done within the arrange view Options, Customize menus/toolbars environment. For information about working in this environment, consult the main REAPER User Guide.

6 Other Performance Preferences
Tucked away under Options, Preferences behind the Advanced Disk I/O settings are two new options.

These are to Periodically close excess file handles and to Memory map peak files smaller than a size that you specify.

If you’re not sure whether you should enable these or not, it probably means that you shouldn’t!

7 Media Item Enhancements
A number of enhancements have been made to media item behavior including those listed in this section.

Dynamic Split

![Dynamic split now allows you to save and recall presets. In the example shown, we have already created two presets, Snare 1 and Snare 2.](image)

Another change is that your dialog box settings will now be remembered when you exit the Dynamic Split dialog by clicking on Cancel.
**Stretch Markers**

Two stretch marker options have been added to the Actions List. These are to add Stretch markers at project tempo changes and to Clear and recalculate auto-stretch at project tempo changes. Neither of these appear on the media item context Stretch markers menu, but you could customize the media item context menu if you wish.

**Auto-Stretch at Tempo Changes**

The option Beats (auto-stretch at tempo changes) has been added to the Item timebase drop down list. This transforms media that has already been tempomapped (or recorded to a click) so that it will stay in time if project tempo changes are added or edited.

Previously, the overall media item length would conform, but you wouldn't get the effect where a single item plays back slower during the slower tempo and faster during the faster tempo.

**8 Playback Offset Enhancements**

**Playback Time Offset**

What's new is found in the track routing window (click the Route button on the track): you can adjust individual tracks to play back media earlier or later. This is commonly used to account for MIDI latency but could be used for other purposes.

In addition, the Actions List now includes an action to Convert embedded source transient information to transient guides.

Being able to configure your MIDI output devices for optimum performance is not a new feature of REAPER. A new enhancement in REAPER 6, however, is that you are now able to enter either a positive or a negative value for output offset time.

This is entered in the Configure MIDI Output dialog, accessed by right-clicking over the output device in the MIDI Devices page of your Preferences and choosing Configure output ... from the context menu.

The Playback page of your Preferences now includes an option to set Max MIDI playback speed when applying negative track playback offset.

In addition, the Actions List includes an action to Bypass track playback offset.

**9 File Rendering Enhancements**

**Changes to Presets**
There are three categories of presets that you can save and recall from the Render to File dialog box. These are **Bounds and output pattern/filename**, **Options and formats**, and **All settings**. Unlike in the past, the **Options and formats** category will now include all of the Options settings. A new option has been added to Embed beat length if exact.

### 10 File Rendering Enhancements

![Render to File dialog box](image)

Optionally, you are able to include for rendering only those regions selected in an existing region render matrix. This means that if you have an existing render matrix of tracks and regions, you can choose to render only certain regions out of that matrix.

Regions are selected via the region manager, or via the region right-click menu. Selecting a region this way only affects this render-selected-regions feature and has no other effect or purpose.

**Rendering with Tempo Embedded**

When **Embed tempo** is enabled, the exact tempo of the rendered item/time will be embedded.

### 11 Embed Transient Information in WAV and AIFF Files

The **Render to File** Dialog now also includes the option **Embed stretch markers/transient guides**. WAV and AIFF files both support embedded information about the file tempo and transients: WAV does this by adding acid chunks: chunk is a term of art, rather like an extension for an audio file. AIFF does this using apple loops chunks.

Previously, REAPER would identify wav/acid tempo information on import and give you the **File contains tempo information** dialog (with the option to adjust), and also supported embedding the project tempo as an acid chunk when rendering WAV.

Significant improvements are:

- Now reaper calculates that tempo more correctly on export as the average tempo of the entire rendered media.
- Now reaper also supports embedding tempo (as beat length, which amounts to the same thing) in AIFF files, via the apple loops chunk.
- Now when importing a WAV or AIFF file that has transient information embedded, reaper will recognize the information and prompt if you would like to either import the file as beat slices (exactly like rex files), or as a single item with transient markers, or just as plain media.
Appendix: Complete REAPER 6.0 Changelog

+ ASIO: permit buffer sizes that are not a power of 2 if the device does not very specifically request otherwise [t=200746]
+ Defaults: enable Live FX multiprocessing by default
+ Defaults: enable track record monitoring on new tracks by default
+ Defaults: set volume envelopes to fader scaling by default
+ Dynamic split: add preset support
+ Dynamic split: overhaul and improvements to algorithm and gate handling
+ Dynamic split: retain settings after canceling the window
+ FX: allow embedding some plug-in UIs into TCP via action or FX menus
+ FX: support embedding UIs for ReaEQ, ReaXComp, ReaComp, ReaSurround, and graphical JSFX
+ FX: add preference to display FX list on right side of FX chain window
+ FX: add preference to display add/delete buttons above list in FX chain window
+ Import: handle WAV and AIF (Apple Loops) files containing transient information similarly to REX files
+ MIDI editor: display and edit CC/velocity as dots and lines, CCs as linear and curved envelopes, similar to track envelopes
+ MIDI editor: add note-type buttons to default toolbar
+ MIDI editor: add option to display note length in velocity lane
+ MIDI editor: add option to move bank/program change events with notes
+ MIDI editor: add preference to automatically reduce CC events when drawing
+ MIDI editor: combine note properties and event properties into one modeless dialog
+ MIDI editor: add mouse modifiers to reset CC/velocity to default values
+ MIDI editor: make default CC event and CC lane mouse modifiers more like default envelope behaviors
+ MIDI editor: repopulate raw MIDI data display window when switching active media item
+ Main window: support positioning TCP on right side of arrange
+ Media import: properly adjust length of imported media with embedded tempo when crossing project tempo changes
+ Media import: support adjusting media based on tempo suggested by filename
+ Media items: add new "Beats (auto-stretch at tempo changes)" timebase
+ Media items: add action to add stretch markers at project tempo changes
+ Media items: add action to recalculate automatic stretch markers at project tempo changes
+ Media items: add action to convert embedded source media transient information to transient guides
+ Media items: optionally create transient guides on import for media with embedded transient information
+ Media items: support calculating playback rate from user-supplied tempo or length in beats
+ Media items: when copy/pasting items with stretch markers, preserve the original play rate
+ Menus: very lightly refresh main file/edit/view/insert menus
+ Misc: fix a few minor memory leaks
+ Modal windows: remember window positions (configurable option in preferences/general/advanced to tweak behavior)
+ Mouse modifiers: add double-click behaviors to reset CC value, curvature, edit properties
+ Mouse modifiers: add preference to draw/edit CC events immediately on mouse click
+ Multiprocessing: auto-detect up to 128 threads
+ Multiprocessing: increase anticipative FX hard limit to 128 threads, live FX hard limit to 64 threads
+ Multiprocessing: remove old 4.x scheduler mode, non-event synchronization modes
+ Notation editor: support customized staff and note context menus
+ Performance: improve performance and system resource consumption with large track counts
+ Performance: add option in disk settings to periodically close excess open files
+ Performance: add option to read peaks files under a certain size completely to RAM (to reduce open file count)
+ REX: add option to ignore all embedded slice and tempo information
+ ReaFIR: add context menu mode configuration
+ ReaScript: add MIDI_GetCCShape, MIDI_SetCCShape
+ ReaScript: add support for CC shapes to MIDI_Get( Set)AllEvts
+ ReaScript: add support for setting track playback offset value and attributes
+ ReaScript: add support for user-defined note and track notation data that is not displayed
+ ReaScript: fix setting MIDI meta-messages via API
+ ReaScript: add reduce_open_files() utility function for users running up against open file handle limitations
+ Render: include all options in "options and format" render presets
+ Render: optionally embed transient information into WAV or AIFF files
+ Render: support embedding tempo into AIFF files
+ Render: support rendering only selected regions in an existing region render matrix [t=193405]
+ Render: when enabled, embed exact tempo of rendered item/time
+ Resampling: added SSE2-optimized sinc calculation (from Theo Niessink)
+ Resampling: optimize and greatly improve quality of resampling for conversion between common rates
+ Routing: add track wiring view
+ Theming: new Default 6.0 theme with theme adjuster script allowing for extensive customization of the new default theme
+ Theming: layout DPI translation for HiDPI/Retina displays
+ Theming: apply main window size area theme element only on mouseover
+ Theming: replace tcp.dragdropchild with tcp.dragdropinfo [indent_sibling_track indent_child_track]
+ Theming: add additional 8 WALTER font slots
+ Theming: add support for midi_score_colormap, in addition to midi_note_colormap
+ Toolbars: actions to switch last focused toolbar will default to switching main toolbar
+ Toolbars: improve HiDPI/Retina support (toolbar_icons/ can have 150/ and 200/ subdirs)
+ Tracks: complete overhaul of track/mixer panels for performance
+ Tracks: support positive or negative playback time offset without affecting PDC
+ Tracks: add action to bypass track playback offset
+ Tracks: add user preference for max MIDI playback speed to catch up to negative track playback offset
+ UI scaling: apply advanced preference scaling changes immediately
+ UI scaling: fix theme rendering bugs when using custom scaling
+ VST3: support plugins that export MIDI note names
+ Windows: HiDPI awareness and display improvements (auto-rescale more UI when running HiDPI aware)
+ Windows: improve appearance of docker, ReaPlugs, and other windows when resizing
+ macOS: Retina display arrange, ruler, MIDI editor, etc
+ macOS: use Metal display output on 10.11+ for various windows
+ macOS: add options in Preferences/General/Advanced to disable Retina support, disable Retina for non-Retina theme elements
+ macOS: support REX files on macOS Catalina
+ macOS: work around appearance issues when user forces dark mode rendering for app (requires Metal to be enabled) [t=222366]

+ MIDI export: fix exporting tempomap when project time offset is negative [t=206959]
+ Metronome: fix setting project custom beat pattern if the project contains measures that are longer than the project default time signature [t=227383]
+ ReWire: allow enabling of 32-bit rewire on Mojave via rewire_allow32=1 in reaper.ini
# MIDI editor: fix moving CC with notes when CC occurs at the very end of the note [p=2205522]
# Media items: when copy/pasting items with stretch markers, apply play rate adjustment rather than adjusting individual stretch markers (because stretch markers may not apply to the entire item)
# Notation editor: fix play cursor updates on Retina
# VST3: support setting all MIDI programs even if the plugin reports a program count of zero [t=226298]
# macOS: fix default positioning of modal windows when using the new default last used window position mode [p=2205500]
# macOS: include theme adjuster script
# theme tweaks/script updates
+ csurf_www: fix hung connection if requesting a directory path on linux/macOS [t=227491]
# Media items: skip MIDI takes when adding automatic stretch markers
# ReaScript: use fixed-width font for console output window
# Windows: make Ctrl+A in directory cleanup behave better in more instances [t=227456]
# macOS: restore Cmd+A behavior in directory cleanup window (5.985 change)
- theme and theme script updates
v6.0rc7 - November 27 2019
  + MIDI editor: fix inserting bank/program events in list view
  + Ripple edit: fix items becoming ungrouped when editing with ripple-per-track enabled [p=2207703]
  # MIDI editor: fix inserting text/sysex/bank/program events in list view [t=227653]
  # Routing Matrix/Wiring diagram: enable faster asynchronous updates on macOS
  # Routing Matrix: macOS Retina display
  # Wiring Diagram: Retina/HiDPI support
  # Wiring diagram: fix accidental horizontal scrolling when vertical scrolling

v6.0rc6 - November 26 2019
  + Configuration: support installing files from (exe path)/REAPERConfigTemplate or (on macOS) /Library/Application Support/REAPER/REAPERConfigTemplate/ to user config path
  + Cursors: use arrow+ibeam for arrange cursor
  + Mouse mappings: use marquee cursor for marquee+time selection combination
  # MIDI editor: fix bezier CC segments changing shape slightly while editing
  # Media explorer: add custom theme color/mode for selection and selection edge
  # Media items: draw automatic stretch markers slightly more visible
  # Theme: fix layout update of envcp when changing track folder state [p=2207324]
  # Toolbar: hidpi image loading defaults to theme non-hidpi images before searching
  Data/toolbar_images/200/ etc

v6.0rc5 - November 25 2019
  + Glue: fix incorrect timing information/transport state reporting/sample accurate automation for take FX [t=222983]
  + Mouse modifiers: improve execution speed of actions to change default mouse modifiers [t=227578]
  # MIDI editor: fix maximum CC lane height [p=2206979]
  # MIDI editor: prevent moving CC event off grid immediately after inserting with certain mouse modifiers [p=2206862]
  # MIDI editor: prevent selecting previous CC event on mouseup after insert [p=2206864]
  # Toolbars: apply composite_toolbar_overlay.png to text icons [p=2207086]
  # Windows: improve HiDPI behavior of docker tabs
  # theme updates

v6.0rc4 - November 24 2019
  # Envelopes: fix crash on running action to insert 4 points [p=2206408]
  # MIDI editor: improve toolbar/piano key sizing when switching to/from hidpi monitors (still not ideal but better)
  # MIDI editor: when clicking CC/velocity events or CC lane, respect MIDI note or piano roll mouse modifier preference to move cursor
  # Windows: another ctrl+a fix for directory cleanup
  # theme updates etc